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Overview
Online Commerce Suite™ is a Web-based payment gateway that allows you to securely process credit card and
electronic check payments for goods and services over the Internet.

First Mile™ MiddleWare is a Windows library that provides an easy way to integrate with the Online Commerce Suite for
your custom applications. First Mile MiddleWare is implemented as a .NET object (including support for COM
interoperability) capable of running on Windows XP (SP2) or later versions of Windows with .NET Framework v 2.0.

What's In This Guide

The Online Commerce Suite First Mile MiddleWare Guide is a technical guide designed for developers familiar with
programming languages such as Visual Basic, C#, or C++. This guide provides all the information necessary to integrate
your custom application with the Online Commerce Suite using First Mile MiddleWare.

How to Comment on This Guide

Every effort has been made to produce an accurate and easy to understand reference. If you have problems with this
document, or find that the instructions are incorrect, incomplete, or inadequate, please let us know.

Contact Information

Email: support@merchantpartners.com

Phone: (866) 242-9933

Documentation

Web Site URL: https://www.onlinemerchantcenter.com/mpartners/html/user_manuals.html
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First Mile™ MiddleWare Reference
First Mile MiddleWare exposes a single object, ATSSecurePostUI, that provides methods for presenting a graphical user
interface that allows users to interactively process transactions. Transaction data is transferred over a Secure HTTP
(HTTPS) connection using the capabilities provided by the .NET framework. First Mile MiddleWare supports several card
readers via plug-in modules to provide card swipe functionality, as well as a few document scanners to provide check
scanning functionality, and signature pads to provide signature capture functionality.

Installation

To install First Mile MiddleWare for use as a COM object, copy the file ATSSecurePostUILib.dll to the location where you
want the object to reside (typically the same location where your application resides, or in the Windows SYSTEM or
SYSTEM32 directory). Register ATSSecurePostUILib.dll with the following command:

RegAsm /codebase ATSSecurePostUILib.dll

RegAsm.exe may not be in your command path. It is a .NET Framework tool located in the .NET Framework installation
directory (e.g., C:\Windows\Microsoft.NET\Framework\v2.0.50727\RegAsm.exe).

Uninstallation

To uninstall First Mile MiddleWare, unregister ATSSecurePostUILib.dll with the following command:

RegAsm /u ATSSecurePostUILib.dll

Delete the file ATSSecurePostUILib.dll from the location you installed it.

Methods

The ATSSecurePostUI object provides the following methods:

string CheckForUpdate(void)
This non-interactive method compares the installed version of First Mile MiddleWare against the latest available
version.

string CheckForUpdates(bool)
This method compares the installed version of First Mile MiddleWare and all hardware add-ons against the latest
available versions and optionally launches the installation process.

void ShowConfigDialog(void)
string ShowConfigDialog(string)

This interactive method allows the user to configure First Mile MiddleWare settings.
string ShowCreditCardForm(string)

This interactive method allows the user to process a credit card or debit card transaction.
string ShowCheckForm(string)

This interactive method allows the user to process a check (ACH/ExtACH/Check21/CheckGuarantee) transaction.
string ShowSignatureCaptureDialog(string, string, short, short)
string ShowSignatureCaptureDialog(string)

This interactive method allows the user to capture a signature image from a signature pad.
string ShowCFNACreditApplication()
string ShowCFNACreditApplication(string)

This interactive method allows the user to submit a CFNA credit application.
string ShowCreditApplication(string)

This interactive method allows the user to submit a credit application.
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string ShowGoodyearApplication(void)
string ShowGoodyearApplication(string)

This method has been superseded by ShowCreditApplication.
string ShowServiceCentralCreditApplication(void)
string ShowServiceCentralCreditApplication(string)

This method has been superseded by ShowCreditApplication.
string ShowAccountLookupDialog(string)

This interactive method allows the user to perform a Drive Card, Goodyear, or Service Central account lookup
(via SSN & Zip Code) or a Balance Inquiry (via Card Number).

string ShowTokenLookupDialog(string)
This interactive method allows the user to perform a Tokenized account lookup (via Token & Last 4 Digits of
payment account number).

string ShowGiftCardDialog(string)
This interactive method allows the user to perform a gift card action (e.g., Issue, Add Value, Balance Inquiry,
Deactivate).

Please note that not all development environments support overloaded methods. If you encounter difficulties calling the
second version of the overloaded methods listed above, you may need to append "_2" to the method name.
Example:

First method:
uiLib.ShowConfigDialog();

Second method:
string strParams = "/ATSID:TEST0/MerchantPIN:1234567890";
string strResult = uiLib.ShowConfigDialog_2(strParams);

Online Commerce Suite™ First Mile™ MiddleWare Guide
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string CheckForUpdate(void)

This method checks the Merchant Partners servers for an updated version of First Mile MiddleWare.

Returns:

string Result

The result of this method call is a multi-line string containing information about the latest available version
of First Mile MiddleWare.

[UPDATE|CURRENT|ERROR]
Identifies the result of the call:

Value Description

UPDATE
Indicates an update is available. Examine the remaining lines of the result to
determine if you want to manually download the latest release.

CURRENT
Indicates the installed version is current. The remaining lines of the result list
information about the latest release.

ERROR Indicates an error in retrieving the information from the server.

VERSION=string
The version number of the latest package.

DATE=MM/DD/YYYY
The date of the latest package.

NAME=string
The base filename of the package.

LINK=URL
The HTTP link where the latest package may downloaded.

SIZE=string
The size of the package archive.

MD5=string
The MD5 hash of the package archive.

Sample result:

CURRENT
VERSION=1.2.24.0
DATE=08/14/2015
NAME=ATSSecurePostUILib.zip
LINK=https://www.onlinemerchantcenter.com/docs/downloads/ATSSecurePostUILib.zip
SIZE=359 KB
MD5=489842f25227985fa5828279a947814e
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string CheckForUpdates(bool)

This method checks the Merchant Partners servers for updated versions of First Mile MiddleWare and all installed
hardware add-ons, and optionally installs any updates found.

Parameters:

bool Install

This parameter controls installation of updated components.

Value Description

true
Launches the installation process if any updates are available. You must release the
ATSSecurePostUI object in order to perform updates; this usually means closing your
application.

false
Do not launch the installation process, even if updates are available, but instead return
information about all available updates.

Returns:

string Result

The result of this method call is a multi-line string containing information about the latest available version
of First Mile MiddleWare and hardware add-ons.

[UPDATING|UPDATE|CURRENT|ERROR]
Identifies the result of the call:

Value Description

UPDATING Indicates updates are available and being installed.

UPDATE

Indicates updates are available. Examine the remaining lines of the result to
determine if you want to manually download the latest versions. If there are multiple
components with updates available, each will be listed in the result following
individual UPDATE lines.

CURRENT Indicates the installed version is current.

ERROR Indicates an error in retrieving the information from the server.

VERSION=string
The version number of the latest package.

DATE=MM/DD/YYYY
The date of the latest package.

NAME=string
The base filename of the package.

LINK=URL
The HTTP link where the latest package may downloaded.

SIZE=string
The size of the package archive.

Online Commerce Suite™ First Mile™ MiddleWare Guide
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void ShowConfigDialog(void)

string ShowConfigDialog(string)

This method shows a configuration dialog with the following tabs:

General – allows the user to enter the Acct ID, Sub ID, and MerchantPIN values to use for transaction processing
and set general options.

• 

Receipt – allows the user to specify the Merchant information to be printed on receipts.• 
ACH – allows the user to specify default ACH settings.• 
Hardware – allows the user to select a compatible card swipe device and enter any additional settings that may
be required for the selected hardware.

• 

Check Scanner – allows the user to select a compatible check scanner and enter any additional settings that may
be required for the selected hardware.

• 

Signature Pad – allows the user to select a compatible signature capture device and enter any additional settings
that may be required for the selected hardware.

• 

Credit Application – allows the user to configure the Apply for Credit popup.• 
Auto-Update – allows the user to configure auto update settings.• 

The Acct ID and Merchant PIN settings are required for all transactions.

The parameterless version of this method persists all settings entered in the dialog.

The second version of this method accepts an initialization parameter and returns the user configured settings which may
be used for the initialization parameter for other methods (e.g., ShowCreditCardForm).

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values. This set of values may contain zero or
more named parameters, each delimited by a slash (/). For each parameter, the name of the parameter
must be separated from the value by a colon (:). Any fields not specified will use the stored value for that
field.

The following named parameters allow you to hide individual tabs in the dialog:

/HideGeneral:
Hides the General tab when a value of 1 is given.

/HideReceipt:
Hides the Receipt tab when a value of 1 is given.

/HideACH:
Hides the ACH tab when a value of 1 is given.

/HideHardware:
Hides the Hardware tab when a value of 1 is given.

/HideCheckScanner:
Hides the Check Scanner tab when a value of 1 is given.

/HideSignaturePad:
Hides the Signature Pad tab when a value of 1 is given.

/HideCreditApplication:
Hides the Credit Application tab when a value of 1 is given.

/HideAutoUpdate:
Hides the Auto-Update tab when a value of 1 is given.

Online Commerce Suite™ First Mile™ MiddleWare Guide
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The following named parameters apply to the General tab:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section).

/PromptForPaymentMethod:
If this parameter is present with the value 1, then the Allow User to Choose Credit/Debit Card or
Check on Sales checkbox is checked.

/P2Fields:
If this parameter is present with the value 1, then the Show Purchase Card Level II Fields
checkbox is checked.

/EnableP3:
If this parameter is present with the value 1, then the Enable Purchase Card Level III Sales
checkbox is checked.

/SwipeImmediate:
If this parameter is present with the value 1, then the Immediately Swipe on Sales/Auths
checkbox is checked.

/ProcessOnSwipe:
If this parameter is present with the value 1, then the Immediately Process Sales/Auths on Card
Swipe checkbox is checked.

/SuppressAcceptedDialog:
If this parameter is present with the value 1, then the Suppress Accepted Dialog checkbox is
checked.

/DisableCashback:
If this parameter is present with the value 1, then the Disable Cashback checkbox is checked.

/AllowAccountLookup:
If this parameter is present with the value 1, then the Allow Account Lookup for Sales checkbox is
checked.

/AllowTokenization:
If this parameter is present with the value 1, then the Allow Account on File checkbox is checked.

/DisableTerms12:
If this parameter is present with the value 1, then the Disable 12 Months No Interest checkbox is
checked.

/TaxRequired:
If this parameter is present with the value 1, then the Require Tax Amount/Exempt Status on
Sales/Auths checkbox is checked.

/EnableGiftCardManager:
If this parameter is present with the value 1, then the Enable Gift Card Manager checkbox is
checked.

/RequireGiftCardActivationSwipe:
If this parameter is present with the value 1, then the Require Swipe for Gift Card Activation/Add
Value checkbox is checked.

/HideAddressGroup:
If this parameter is present with the value 1, then the Hide Address Group on Sales checkbox is
checked.

/HideIdGroup:
If this parameter is present with the value 1, then the Hide Identification Group on Sales
checkbox is checked.

/HideVacGroup:
If this parameter is present with the value 1, then the Hide Voice Auth Capture Group on Sales
checkbox is checked.

Online Commerce Suite™ First Mile™ MiddleWare Guide
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/MerchantIndustry:
This parameter identifies the merchant industry which may have built-in business rules. Valid
values are

Value Description

A Auto Rental

D Direct Marketing

E E-Commerce

F Food/Restaurant

H Hotel/Lodging

L Loan Repayment

O Oil/Fueling

R Retail

The following named parameters apply to the Receipt tab:

/MerchantName:
Specifies the Merchant name to be printed on the first line of the receipt.

/MerchantAddress:
Specifies the Merchant address to be printed on the second line of the receipt.

/MerchantCityStateZip:
Specifies the Merchant city, state and zip to be printed on the third line of the receipt.

/MerchantPhone:
Specifies the Merchant phone number to be printed on the fourth line of the receipt.

/ReceiptCopies:
Sets the default number of copies when the user chooses to print the receipt.

/AutoPrintReceipt:
If this parameter is present with the value 1, then the Automatically Print Receipt checkbox is
checked.

/ReceiptCopies2:
If this parameter is present with the value 1, then the Print two copies per page checkbox is
checked.

/ReceiptText:
Specifies additional text to print on receipts.

The following named parameters apply to the ACH tab:

/TerminalCity:
Four-character abbreviated name for the city where the POS terminal is located.

/TerminalState:
Two-character state abbreviation of the state where the POS terminal is located.

/ACHMethod:
Default ACH method:

Value Description

ACH Standard ACH

ExtACH Extended ACH

Check21 Check21

Online Commerce Suite™ First Mile™ MiddleWare Guide
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CheckGuarantee Check Guarantee

PaperGuarantee Paper Guarantee

/SECCode:
Default SEC code:

Value Description

ARC Accounts Receivable Conversion

BOC Back Office Conversion

ICL Image Cash Letter

POP Point of Purchase

PPD Prearranged Payment/Deposit

RCK Re-Presented Check

TEL Telephone-Initiated Entry

/VerificationEnabled:
Whether check verification is enabled (1) or disabled (0).

The following named parameters apply to the Credit Application tab:

/CreditAppPopup:
If this parameter is present with the value 1, then the Apply for Credit Popup defaults to On.

/CreditAppPopupProvider:
Identifies the selected credit application provider:

Value Description

GEMY CarCareONE

CFNA CFNA

DRVE Drive Card

GDYR Goodyear

SERV Service Central

/CreditAppPopupAmount:
Specifies the Trigger Amount at which the credit application popup will be displayed.

/AutoQuickScreen:
This parameter only applies to CarCareONE. It indicates whether QuickScreen should be
executed for Sales and Auths.

/ShowQuickScreenDecline:
This parameter only applies to CarCareONE. It indicates whether QuickScreen Declines should
be shown when AutoQuickScreen is enabled.

The following named parameters apply to the Auto-Update tab:

/CheckForUpdates:
A value of 0 indicates the library should never check for updates, a value of 1 indicates that
updates should be queried based on the update interval.

Online Commerce Suite™ First Mile™ MiddleWare Guide
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/CheckForUpdateInterval:
Specifies the number of days between checks for update.

The following named parameters are also supported:

/CenterScreen:
If this parameter is present with the value 1, the dialog is shown centered on the screen rather
than the default position of centering the dialog on the calling window.

/Query:
This parameter allows querying specific configuration information. The following table shows
supported values and changes to the result:

Value Description Result

IsSigPadAvailable
Indicates whether a signature
pad is available.

Returns YES if a signature pad is
available, NO otherwise.

Example:

/ATSID:TEST0/MerchantPIN:123abc789/HideReceipt:1

Returns:

string Result

The result of this method call is a string containing the user configured settings. This string may be used
in the initialization parameter for other method calls (e.g., ShowCreditCardForm).

Example:

/ATSID:TEST0/MerchantPIN:123abc789/P2Fields:1

If the /Query: named parameter was supplied in the method call, then the result will instead contain the
information described in the Query Values table.

Online Commerce Suite™ First Mile™ MiddleWare Guide
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string ShowCreditCardForm(string)

This method shows the credit card processing form.

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values and control its behavior. This set of
values may contain zero or more parameters, each delimited by a slash (/). For each parameter, the
name of the parameter must be separated from the value by a colon (:).

The following named parameters are supported:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant. If omitted and the
ShowConfigDialog method has never been called, then this method will automatically call the
ShowConfigDialog method to collect this required information.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section). If omitted and the ShowConfigDialog method has
never been called, then this method will automatically call the ShowConfigDialog method to
collect this required information.

/TransactionType:
Identifies the transaction type:

Value Description

Sale Perform a sale.

PreAuth Perform a pre-authorization.

PostAuth Perform a post on a previous auth-only transaction.

VAC Perform a sale with Voice Authorization Capture information.

Refund Perform a refund of a previous transaction.

Void Perform a void of a previous transaction.

Credit Perform a stand-alone credit.

BillPayment Perform a PINless debit sale transaction.

AccountPayment Record an account payment (for supported card types).

AccountPaymentReversal Reverse an account payment (for supported card types).

/Amount:
Dollar amount of the transaction (e.g., 1.23)

/MerchantOrderNumber:
(alias /Receipt:)
A value, unique to the merchant, by which the merchant can easily reference the order in the
Online Merchant Center and reports.

/RefCode:
RefCode captured from a pre-authorization transaction. This parameter only applies to the
PostAuth transaction type.

Online Commerce Suite™ First Mile™ MiddleWare Guide
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/OrderID:
The Order ID associated with an existing transaction. This parameter only applies to the Refund
and Void transaction types.

/TransactionID:
The Transaction ID of an existing transaction. This parameter only applies to the Refund and
Void transaction types.

/RequireTax:
If this parameter is present with the value 1, the user must either specify a tax amount or tax
exempt status in order to process the transaction.

/TaxAmount:
Dollar amount of tax collected for the transaction (e.g., 1.23)

/TaxExempt:
Indicates whether the transaction is tax exempt. Use 1 to indicate tax exempt; omit or use 0 to
indicate a taxable purchase.

/CashbackAmount:
Specifies the cashaback amount (e.g., 1.23)

/Memo:
(alias /Clerk:)
Transaction memo; 256 character maximum.

/CenterScreen:
If this parameter is present with the value 1, the dialog is shown centered on the screen rather
than the default position of centering the dialog on the calling window.

/LockParameters:
If this parameter is present with the value 1, the following fields, if provided in the parameter set,
will be locked as read-only: Order Number, Amount, Tax Amount, Tax Exempt, and Cashback.

/SwipeImmediate:
If this parameter is present with the value 1, then the Swipe dialog is shown immediately upon
launch of the credit card form. This only applies if the transaction type is PreAuth, VAC, or Sale
and may also require the Amount parameter depending on the selected hardware.

/ProcessOnSwipe:
If this parameter is present with the value 1, then the transaction is processed immediately after a
successful card swipe. This only applies if the transaction type is PreAuth, VAC, or Sale and
may also require the Amount parameter depending on the selected hardware.

/ProcessImmediate:
When this parameter is present with the value 1 and additional required parameters are given, a
transaction will be executed without user interaction. This only applies if the transaction type is
PostAuth, Refund, or Void.

TransactionType Required Parameters Optional Parameters

PostAuth Amount, RefCode

Refund OrderID, TransactionID Amount

Void OrderID, TransactionID

If any required parameter is missing or invalid, the user will be presented with the standard
dialog.

/SuppressAcceptedDialog:
Specify 1 to suppress the Accepted dialog which is normally shown for accepted transactions.
Declined, Duplicate Transaction, and Partial Approval dialogs will still be shown.

/SuppressPartialAcceptedDialog:
Even when the Accepted dialog is suppressed with the above parameter, a Partial Approval
transaction will still show the Accepted dialog. Specify 1 to override this behavior.

/AcceptedDialogTimeout:
This parameter causes the Accepted dialog which is normally shown for accepted transactions to
be automatically dismissed after the given number of seconds.

Online Commerce Suite™ First Mile™ MiddleWare Guide
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/DisableOverridePIN:
By default, a stand-alone credit transaction requires an Override PIN to be entered by the user.
The Override PIN must be configured in the gateway account. If your software manages its own
similar restriction you can disable this requirement by providing a value of 1 for this parameter.

/DisableCashback:
Specify 1 to disable cashback for PIN debit transactions.

/EnableGiftCardManager:
Specify 1 to display the Gift Card Manager button on the Sale dialog.

/RequireGiftCardActivationSwipe:
Specify 1 to require a swipe for Gift Card Activation/Add Value.

/ExitOnDecline:
If this parameter is present with the value 1, then the transaction dialog is automatically
dismissed if the transaction is declined.

/ExitOnCancelledSwipe:
If this parameter is present with the value 1, then the transaction dialog is automatically
dismissed if the swipe is cancelled.

/HideAddressGroup:
Specify 1 to hide the Address group of fields on the Sale dialog.

/HideIdGroup:
Specify 1 to hide the Identification group of fields on the Sale dialog.

/HideVacGroup:
Specify 1 to hide the Voice Auth Capture group of fields on the Sale dialog.

/CheckForUpdateInterval:
The number of days between checks for updates.

/CheckForUpdates:
Specify 0 to disable checking for updates, or 1 to enable update checking for updates.

/NameOfStation:
Name of station associated with the transaction.

/ISVUser:
ISV User associated with the transaction.

/ISVEMV:
Specify 1 to receive the RECEIPTGROUP response elements. The RECEIPTGROUP response
elements may include EMV information (required for printed receipts). If this parameter is not
present (or set to 0), EMV response elements (if available) are included in the TERMS response
element.

/ReturnAddress:
Specify 1 to include the consumer address information in the transaction results. The address
information is only available if provided with the transaction.

The following named parameters apply to the Apply for Credit popup:

/CreditAppPopup:
Specify 0 to disable the Apply for Credit popup, or 1 to enable it.

/CreditAppPopupAmount:
Specifies the minimum transaction amount that triggers the Apply for Credit popup.

/CreditAppPopupProvider:
Specifies the credit application provider to use when the user accepts the Apply for Credit popup.
Valid values are

Value Description

CFNA Use the CFNA Credit Application

DRVE Use the Drive Card Credit Application
Drive Card

Online Commerce Suite™ First Mile™ MiddleWare Guide
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GDYR Use the Goodyear Credit Application
Goodyear

SERV Use the Service Central Credit Application
Service Central

GEMY Use the CarCareONE Credit Application
CarCareONE

/IncludeCreditAppResult:
Specify 1 to include the credit application response in the results.
The following additional elements may be included in the transaction result:
APPDETAIL, APPTRANSACTIONID, APPORDERID, APPCONFIRMATIONNUMBER,
APPTOKEN, APPLAST4DIGITS, APPCARDNUMBER, APPCREDITLIMIT, APPBALANCE,
APPFIRSTNAME, APPLASTNAME, APPADDRESS1, APPADDRESS2, APPCITY, APPSTATE,
APPZIPCODE, APPPHONE, APPEMAIL.
See the Results section of the ShowCreditApplication method for more information.

/MaskCreditAppCardNum:
Specify 1 to mask the newly created credit card number that is returned in the APPCARDNUMBER
transaction result. This value is only returned if the credit application is successful and not
tokenized.

/TokenizeCreditApp:
Specify 1 to tokenize the accepted credit application. The sale/auth will use the newly tokenized
account for the payment. This parameter overrides the Tokenize parameter described below.

The following named parameters apply to tokenization:

/AllowTokenization:
Specify 1 to enable tokenization. This overrides the "Allow Account on File" setting in the
Configuration dialog.

/Tokenize:
Specify 1 to default the 'Store this card on file?' option to 'Yes'. Additionally, if a credit application
is accepted (see above), the newly created account will be tokenized.

/Token:
Numeric token supplied by Merchant Partners.

/Last4Digits:
The last four digits of the credit card or bank account number.

The following named parameters specify customer information:

/CCName:
(alias /CardholderName:)
Full name of the card holder (e.g., John Q. Customer)

/Address1:
(alias /Address:)
Cardholder street address (e.g., 123 Main St)

/Address2:
Cardholder street address second line (e.g., Suite 202)

/City:
Cardholder city (e.g., Redmond)

/State:
Cardholder state (e.g., WA)

/Zip:
Cardholder zip code (e.g., 98052)
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/Phone:
Consumer's phone number (e.g., 888-555-1212)

/Email:
Consumer's email address (e.g., john@example.com)

/SSN:
Social Security number.

/PhotoIDType:
Specifies the Photo ID type. Valid values are

Value Description

D Driver License (default)

G Green Card

M Military ID

P Passport

S State ID Card

/PhotoIDNumber:
Specifies the identification number (which may contain characters) on the Photo ID.

/PhotoIDExpDate:
Specifies the Photo ID expiration date in format MM-DD-YYYY or MM-YYYY.

The following named parameters apply to receipts:

/MerchantName:
Specifies the Merchant name to be printed on the first line of the receipt.

/MerchantAddress:
Specifies the Merchant address to be printed on the second line of the receipt.

/MerchantCityStateZip:
Specifies the Merchant city, state and zip to be printed on the third line of the receipt.

/MerchantPhone:
Specifies the Merchant phone number to be printed on the fourth line of the receipt.

/HideReceiptButton:
If this parameter is present with the value 1, then the Print Receipt button normally shown on the
successful transaction result dialog is hidden.

/AutoPrintReceipt:
If this parameter is present with the value 1, then a receipt is automatically printed upon
successful completion of a PreAuth, VAC, Sale, or Credit transaction.

/ReceiptCopies:
Sets the default number of copies when the user chooses to print the receipt.

/ReceiptCopies2:
Specify 1 to attempt printing two copies of the receipt whenever the receipt is printed.

/ReceiptText:
Specify additional text to print at the bottom of the receipt.

The following named parameters apply to the signature image:

/ReturnImageEncoding:
Identifies the encoding in which you would like the signature image returned. Since the
ShowCreditCardForm method returns a string value, the image must be encoded in a string
representation. Valid values are

Online Commerce Suite™ First Mile™ MiddleWare Guide
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Value Description

Base64
Radix-64 encoding; the base 64 digits in ascending order from zero are the uppercase
characters 'A' to 'Z', the lowercase characters 'a' to 'z', the numerals '0' to '9', and the
symbols '+' and '/'. The valueless character, '=', is used for trailing padding.

BinHex
Binary to Hexadecimal encoding; each byte is converted to a hexadecimal string
representation.

If this parameter is not specified, no image is returned.
/ReturnImageFormat:

Identifies the image format in which you would like the signature image returned. Valid values are

Value Description

Bmp Windows bitmap

Emf Enhanced Windows metafile

Gif Graphics Interchange Format

Jpeg Joint Photographic Experts Group image format

Pcl Printer Control Language format

Png Portable Network Graphics image format

Tiff Tag Image File Format

Wmf Windows metafile

Defaults to Tiff if not specified.
/ReturnImageHeight:

Specifies the maximum image height in pixels.
Default: 100.

/ReturnImageWidth:
Specifies the maximum image width in pixels.
Default: 500.

/SignaturePrompt:
Specifies the prompt to display on the hardware device (if supported) for signature capture
operations.

/SignatureOptional:
Specify 1 to make the signature optional for PIN Debit transactions.

The following named parameters apply to Purchase Card information:

/P2Fields:
Specify 1 to enable Purchase Card Level II fields. This only applies if the transaction type is
PreAuth, VAC, or Sale.

/EnableP3:
Specify 1 to enable Purchase Card Level III line item detail for sales transactions. This only
applies when /P2Fields:1.

/POCustomerRefID:
If P2Fields are enabled, this parameter may be used to specify a cardholder's customer ID or
reference number for the Purchase Card.

/SupplierRefNum:
If P2Fields are enabled, this parameter may be used to specify a reference number that helps
the merchant identify the charge in case of an inquiry by the credit card company. (AMEX
Commercial Card only).
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/CardholderRefNum:
If P2Fields are enabled, this parameter may be used to specify a card holder reference
number. (AMEX Commercial Card only).

/ChargeDescriptor:
If P2Fields are enabled, this parameter may be used to describe the charge. (AMEX
Commercial Card only).

The following named parameters apply to CarCareONE, Drive Card, Goodyear, and Service Central
cards:

/AllowAccountLookup:
If this parameter is present with the value 1, then the Account Lookup button is displayed on the
Sale dialog to allow account lookup/balance inquiries prior to performing the sale.

/PromoCode:
For the CarCareONE card, this 3- or 4-digit value identifies the promo code for the transaction.

/AutoQuickScreen:
This parameter overrides the "Automatically QuickScreen Sales/Auths" setting in the Credit
Application tab of the Configuration dialog when CarCareONE is selected as the provider.
Pass 1 to perform a background CarCareONE QuickScreen when the Sale dialog is shown. A
QuickScren can only be performed if CardholderName, Address1, City, State, and Zip are
provided. Pass 0 to bypass an automatic QuickScreen.

/ShowQuickScreenDecline:
This parameter overrides the "Show QuickScreen Declines" setting in the Credit Application tab
of the Configuration dialog when CarCareONE is selected as the provider.
If an automatic CarCareONE QuickScreen is declined by the processor, sending a 1 for this
parameter will show the Decline dialog. Sending a 0 for this parameter suppresses the Decline
dialog.

/Terms:
For Drive Card, Goodyear, and Service Central cards, this identifies the ticket terms for the
transaction. Valid values are

Value Description

0001 Revolve Sale

0060 6 Months No Interest

0012 12 Months No Interest

/DisableTerms12:
If this parameter is present with the value 1, the 12 Months No Interest option for the Drive Card,
Goodyear, and Service Central ticket terms is disabled.

The following named parameters apply to Fleet cards:

/DefaultFCProductCode:
For Fleet cards, this identifies the default product code for the transaction. The default product
code is used to generate the Line Item detail when not submitted by the user. For valid values,
see Appendix B.

/FleetRC:
For Fleet cards, this parameter sets the RC field for keyed entries. The RC field determines the
service restrictions and prompts applicable to the card.

/DepartmentNumber:
For Wright Express fleet cards, this parameter sets the Department # service prompt field.

/DLNumber:
Driver license number; required for some Fleet cards.
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/DriverID:
For Fleet cards, this parameter sets the Driver ID service prompt field.

/IDNumber:
For Fleet cards, this parameter sets the ID service prompt field.

/JobNumber:
For Wright Express fleet cards, this parameter sets the Job # service prompt field.

/LineItems:
For Fleet cards, this parameter may contain the line item details for the transaction. Refer to
Appendix A for more information.

/MiscNumericData:
For Wright Express fleet cards, this parameter sets the Cust Data service prompt field.

/OdometerReading:
For Fleet cards, this parameter sets the Odometer service prompt field.

/PurchaseDevSequenceNumber:
For Wright Express fleet cards, this parameter sets the Purchase Dev. Seq. # service prompt
field.

/VehicleID:
For Fleet cards, this parameter sets the Vehicle ID service prompt field.

The following named parameters apply to PINless debit transactions:
Note: when MerchantIndustry is Loan Repayment, all sales are performed as PINless debit
transactions.

/BillingAccountNumber:
Acccount number that merchant uses to identify customer in their system.

/InvoiceNumber:
Optional merchant invoice number.

All parameters are optional and may be omitted.

Example:

/TransactionType:PreAuth/Amount:1.25

Returns:

string Result

The result of this method call is a multi-line string containing information about the transaction that was
processed. Each result element is separated by a CR/LF. Not every element will be present for all
transactions. Additional elements may be added in the future.

RESULT=[NONE|SUCCESS|DECLINED|ERROR]
Indicates the status of the call:

Value Description

NONE Indicates no transaction was performed.

SUCCESS Indicates the transaction was successful.

DECLINED Indicates the transaction was declined.

ERROR Indicates an error occurred.

Note: if Auto Updates are enabled and the user assents to the Auto Update process, the value of
this tag will be NONE and the DETAIL tag will contain the value Update in progress.
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ACCOUNT=numeric
The last 4 digits of the credit card that was processed.

AMOUNT=decimal
The amount of the transaction.

EXPIRATION=MM/YYYY
The expiration date of the credit card that was processed.

APPROVALCODE=string
The Authorization Code of the transaction.

NAME=string
The Account Holder name, if available.

TRANSACTIONID=numeric
The Online Merchant Center Transaction ID for the transaction.

ORDERID=numeric
The Online Merchant Center Order ID for the transaction.

DETAIL=string
This value identifies the transaction type and any additional information about the transaction.
For successful transactions, this value depends on the transaction type:

TransactionType Detail

Sale No additional information is provided.

PreAuth The pre-authorization RefCode is provided.

PostAuth
The pre-authorization RefCode that was used for the post-authorization is
provided.

VAC
The Voice Authorization Capture Code that was included with the transaction
is provided.

Refund No additional information is provided.

Void No additional information is provided.

For declined transactions, this value contains the processing gateway's decline reason.

For partial approval transactions, the result will have the string -PARTIAL appended.

If the user assents to the Auto Update process, this tag will contain the value Update in progress
ACCOUNTTYPE=string

Identifies the credit card type that was processed:

 AMEX  CarCareONE  CFNA  Check

 Debit  Diners Club  Discover Network  Drive Card

 Fleet One  Flying J  FuelLynk  FuelMan

 GE Money  Goodyear  JCB  MasterCard

 MasterCard Fleet  Service Central  Visa  Visa Fleet

 Voyager  WP Gift Card  Wright Express

PARTIAL_APPROVAL=1
In the event of a partial authorization, this flag will be included in the results. Additionally, the
AMOUNT tag identifies the partial amount that was approved.

TERMID=string
This optional tag may be included to identify the Terminal on which the transaction originated.

MERCHANTID=string
This optional tag may be included to identify the Merchant.
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BALANCE=numeric
Balance remaining on card (not supported for all card types).

TERMS=string
For certain card types (e.g., CarCareONE, Goodyear, Drive Card, and Service Central),
additional information may be required for printed receipts. This information is included in this tag.
If the /ISVEMV:1 parameter was not provided, EMV information may be provided in this element
for EMV transactions. The value may include the 2-character sequence [] to indicate where
newlines would be used.

ODOMETERREADING=string
For Fleet cards, if the Odometer service prompt was required for the transaction, it is included in
this tag which should be printed on receipts.

VEHICLEID=string
For Visa Fleet and Wright Express fleet cards, if the Vehicle ID service prompt was required for
the transaction, it is included in this tag which should be printed on receipts.

PURCHASEDEVSEQUENCENUMBER=string
For Wright Express fleet cards, if the Purchase Dev. Seq. # service prompt was required for the
transaction, it is included in this tag which should be printed on receipts.

TOKEN=numeric
For Tokenized transactions, whether creating a new tokenized account or using an existing
tokenized account to perform a transaction, the value indicates the Merchant Partners token that
is required for subsequent transactions against the tokenized account.

LAST4DIGITS=numeric
For Tokenized transactions, this value indicates the last four digits of the payment account for the
tokenized account.

ENTRYMETHOD=string
Indicates whether the transaction was SWIPED or KEYED.

If the /ReturnAddress:1 parameter was provided and a consumer address was submitted with the
transaction, the following elements will be available:

ADDRESS1=string
Street address of the consumer.

ADDRESS2=string
Second line of the street address of the consumer.

CITY=string
City of the consumer's address.

STATE=string
State of the consumer's address.

ZIPCODE=string
Zip code of the consumer's address.

PHONE=string
Consumer's phone number.

EMAIL=string
Consumer's email address.

If the /ISVEMV:1 parameter was provided, the response will contain the following elements that may be
used for printing a receipt. Each group contains name/value pairs with a "|" (pipe) as a delimiter and a ":"
(colon) as a separator between the name and value. Not all pairs will be present at all times. Additional
elements may be added in the future.

RECEIPTGROUP1=string
This group contains cardholder and transaction data.
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Name Description

TRANSACTIONTYPE
Indicates the type of transaction processed:
SALE, AVSSALE, AUTH, AVSAUTH, POST, AVSPOST,
VOICEPOST, VOID, CREDIT

TRANSACTIONRESULT
Indicates whether the transaction was APPROVED or
DECLINED.

TIMESTAMP
Timestamp of the transaction in the format MM/DD/YYYY
hh:mm:ss AMPM (e.g., 8/20/2015 4:20:05 PM).

MERCHANTORDERNUMBER Merchant order number (if provided).

MERCHANTID Merchant identifier, masked to the last four digits.

TERMID Terminal identifier.

AMOUNT Amount of the transaction.

CASHBACK Cashback amount.

ENTRYMETHOD
Entry method:
SWIPED, KEYED, EMV CONTACT, EMV CONTACTLESS,
FALLBACK SWIPE, FALLBACK KEYED, RFID

NAME Cardholder name.

ACCOUNTTYPE
Payment type. See the ACCOUNTTYPE element above for
valid values.

ACCOUNT Card number, masked to the last four digits.

ORDERID The Online Merchant Center Order ID for the transaction.

TRANSACTIONID
The Online Merchant Center Transaction ID for the
transaction.

AUTHCODE
The authorization or approval code provided by the
authorizing network.

DECLINECODE
If the transaction was declined, this value contains the
10-digit decline code.

DECLINEMESSAGE
For declined transactions, this value may contain a message
indicating the reason for the decline.

BATCHNUMBER
Batch settlement number in which this transaction is
included.

AVSRESULT Result code generated by the Address Verification System.

CVV2RESULT
One character result code generated by the CVV2/CVC2
system.

ODOMETERREADING
For Fleet cards, if the Odometer service prompt was required
for the transaction, it is included in this tag which should be
printed on receipts.

VEHICLEID
For Visa Fleet and Wright Express fleet cards, if the Vehicle
ID service prompt was required for the transaction, it is
included in this tag which should be printed on receipts.

PURCHASEDEVSEQUENCENUMBER
For Wright Express fleet cards, if the Purchase Dev. Seq. #
service prompt was required for the transaction, it is included
in this tag which should be printed on receipts.

BALANCE Balance remaining on card (not supported for all card types).
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RECEIPTGROUP2=string
This group contains EMV receipt data.

Name Description

APPLABEL Application Name

AID ApplicationID

TVR Terminal Verification Results

IAD Issuer Application Data

TSI Transaction Status Indicator

ARQC Application Cryptogram

ARC Authorization Response Code

CVM Cardholder Verification Method (P(PIN), S(SIGNATURE), N(NONE))

RECEIPTGROUP3=string
This group contains terms or information as demanded by the card brand.

Name Description

TERMS
For certain credit cards (e.g., CarCareONE, Goodyear, Drive Card, and Service
Central), additional information may be required for printed receipts. This information is
included in this tag.

If the ReturnImageEncoding parameter is provided and a signature image was captured, the following
element will be included

SIGNATURE=string
This value contains the image in the format determined by the ReturnImageFormat parameter
with dimensions specified by ReturnImageWidth and ReturnImageHeight (if supported by
the signature capture device).

Example:

RESULT=SUCCESS
ACCOUNT=5454
AMOUNT=1.25
EXPIRATION=12/2015
APPROVALCODE=SALE:000111:12345678::123456789:::
NAME=DEFAULT TEST
TRANSACTIONID=123456789
ORDERID=123456999
DETAIL=Sale
ACCOUNTTYPE=MasterCard
TERMID=123789
ENTRYMETHOD=SWIPED
MERCHANTID=123456789012788
RECEIPTGROUP1=TRANSACTIONTYPE:SALE|TRANSACTIONRESULT:APPROVED|TIMESTAMP:8/21/2015 4:20…
RECEIPTGROUP2=
RECEIPTGROUP3=
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string ShowCheckForm(string)

This method shows the check processing form.

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values. This set of values may contain zero or
more named parameters, each delimited by a slash (/). For each parameter, the name of the parameter
must be separated from the value by a colon (:).

The following named parameters are supported:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant. If omitted and the
ShowConfigDialog method has never been called, then this method will automatically call the
ShowConfigDialog method to collect this required information.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section). If omitted and the ShowConfigDialog method has
never been called, then this method will automatically call the ShowConfigDialog method to
collect this required information.

/TransactionType:
Sets the transaction type selection. The following values are supported:

Value Description

Sale Perform a Sale.

Refund Perform a refund of a previous transaction.

Void Perform a void of a previous transaction.

/ACHMethod:
Override the default ACH method:

Value Description

ACH Standard ACH

ExtACH Extended ACH

Check21 Check21

CheckGuarantee Check Guarantee

/Amount:
Dollar amount of the transaction (e.g., 1.23)

/MerchantOrderNumber:
A value, unique to the merchant, by which the merchant can easily reference the order in the
Online Merchant Center and reports.
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/SECCode:
Allows overriding the default SEC code:

Value Description

ARC Accounts Receivable Conversion

BOC Back Office Conversion

ICL Image Cash Letter

POP Point of Purchase

PPD Prearranged Payment/Deposit

RCK Re-Presented Check

TEL Telephone-Initiated Entry

/TerminalCity:
Four-character abbreviated name for the city where the POS terminal is located.

/TerminalState:
Two-character state abbreviation of the state where the POS terminal is located.

/Verification:
If this parameter is present with the value 1, check verification is enabled.

/OrderID:
The Order ID associated with an existing transaction. This parameter only applies to the Refund
and Void transaction types.

/TransactionID:
The Transaction ID of an existing transaction. This parameter only applies to the Refund and
Void transaction types.

/Memo:
Transaction memo; 256 character maximum.

/CenterScreen:
If this parameter is present with the value 1, the dialog is shown centered on the screen rather
than the default position of centering the dialog on the calling window.

/LockParameters:
If this parameter is present with the value 1, then the Order Number and Amount fields, if
provided in the parameter set will be locked in the Sale dialog.

/ScanImmediate:
If this parameter is present with the value 1, then the Check Scan dialog is shown immediately
upon launch of the form. This only applies if the transaction type is Sale.

/ProcessImmediate:
When this parameter is present with the value 1 and additional required parameters are given, a
transaction will be executed without user interaction. This only applies if the transaction type is
Refund or Void.

TransactionType Required Parameters Optional Parameters

Refund OrderID, TransactionID Amount

Void OrderID, TransactionID

If any required parameter is missing or invalid, the user will be presented with the standard
dialog.

/SuppressAcceptedDialog:
If this parameter is present with the value 1, then the Accepted dialog which is normally shown for
accepted transactions will be suppressed. Decline and Duplicate Transaction dialogs will still be
shown.
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/AcceptedDialogTimeout:
This parameter causes the Accepted dialog which is normally shown for accepted transactions to
be automatically dismissed after the given number of seconds.

The following named parameters specify account information:

/AccountName:
Name of the account owner (e.g., John Q. Customer)

/CompanyName:
Company Name (applicable when CheckingAccountType is Business).

/SignatoryFirstName:
First name of the signatory.

/SignatoryLastName:
Last name of the signatory.

/CheckingAccountType:
Identifies the checking account type:

Value Description

Personal Standard ACH

Business Check Guarantee

/RoutingNumber:
Nine-digit numeric value for checking account routing or ABA number.

/AccountNumber:
Variable length numeric value for checking account number.

/CheckNumber:
Check Number.

The following named parameters apply to tokenization:

/AllowTokenization:
Specify 1 to enable tokenization. This overrides the "Allow Account on File" setting in the
Configuration dialog.

/Tokenize:
Specify 1 to default the 'Store this card on file?' option to 'Yes'.

/Token:
Numeric token supplied by Merchant Partners.

/Last4Digits:
The last four digits of the bank account number.

The following named parameters specify customer information:

/Address1:
Account owner street address (e.g., 123 Main St).

/HouseNumber:
Account owner house number (e.g., 123).

/Street:
Account owner street (e.g., Main St.).

/Address2:
Account owner street address second line (e.g., Suite 202)

/City:
Account owner city (e.g., Redmond)
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/State:
Account owner state (e.g., WA)

/Zip:
Account owner zip code (e.g., 98052)

/Phone:
Account owner phone number (e.g., 888-555-1212)

/Email:
Account owner email address (e.g., john@example.com)

/DLNumber:
Driver license number.

/SSN:
Social Security number.

The following named parameters apply to receipts:

/MerchantName:
Specifies the Merchant name to be printed on the first line of the receipt.

/MerchantAddress:
Specifies the Merchant address to be printed on the second line of the receipt.

/MerchantCityStateZip:
Specifies the Merchant city, state and zip to be printed on the third line of the receipt.

/MerchantPhone:
Specifies the Merchant phone number to be printed on the fourth line of the receipt.

/HideReceiptButton:
If this parameter is present with the value 1, then the Print Receipt button normally shown on the
successful transaction result dialog is hidden.

/AutoPrintReceipt:
If this parameter is present with the value 1, then a receipt is automatically printed upon
successful completion of a Sale transaction.

/ReceiptCopies:
Sets the default number of copies when the user chooses to print the receipt.

/ReceiptCopies2:
Specify 1 to attempt printing two copies of the receipt whenever the receipt is printed.

/ReceiptText:
Specify additional text to print at the bottom of the receipt.

The following named parameters apply to CarCareONE QuickScreen:

/AutoQuickScreen:
This parameter overrides the "Automatically QuickScreen Sales/Auths" setting in the Credit
Application tab of the Configuration dialog when CarCareONE is selected as the provider.
Pass 1 to perform a background CarCareONE QuickScreen when the Sale dialog is launched. A
QuickScren can only be performed if CardholderName, Address1, City, State, and Zip are
provided. Pass 0 to bypass an automatic QuickScreen.

/ShowQuickScreenDecline:
This parameter overrides the "Show QuickScreen Declines" setting in the Credit Application tab
of the Configuration dialog when CarCareONE is selected as the provider.
If an automatic CarCareONE QuickScreen is declined by the processor, sending a 1 for this
parameter will show the Decline dialog. Sending a 0 for this parameter suppresses the Decline
dialog.

All parameters are optional and may be omitted.
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Example:

/SECCode:TEL/Amount:10.25/Phone:888-555-1212

Returns:

string Result

The result of this method call is a multi-line string containing information about the transaction that was
processed. Each result element is separated by a CR/LF. Not every element will be present for all
transactions. Additional elements may be added in the future.

RESULT=[NONE|SUCCESS|DECLINED|ERROR]
Indicates the result of the call:

Value Description

NONE Indicates no transaction was performed.

SUCCESS Indicates the transaction was successful.

DECLINED Indicates the transaction was declined.

ERROR Indicates an error occurred.

Note: if Auto Updates are enabled and the user assents to the Auto Update process, the value of
this tag will be NONE and the DETAIL tag will contain the value Update in progress.

ACCOUNT=numeric
The last 4 digits of the bank account number that was processed.

AMOUNT=decimal
The amount of the transaction.

APPROVALCODE=string
The Authorization Code of the transaction.

NAME=string
The Account Holder name, if available.

TRANSACTIONID=numeric
The Online Merchant Center Transaction ID for the transaction.

ORDERID=numeric
The Online Merchant Center Order ID for the transaction.

DETAIL=string
For declined transactions, this value contains the processing gateway's decline reason.
If the user assents to the Auto Update process, this tag will contain the value Update in progress

ACCOUNTTYPE=string
Account type, if available (e.g., Checking or Savings).

CHECKNUMBER=string
Check number, if available.

TOKEN=numeric
For Tokenized transactions, whether creating a new tokenized account or using an existing
tokenized account to perform a transaction, the value indicates the Merchant Partners token that
is required for subsequent transactions against the tokenized account.

LAST4DIGITS=numeric
For Tokenized transactions, this value indicates the last four digits of the payment account for the
tokenized account.

ENTRYMETHOD=string
The entry method of the transaction.
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To allow easy printing of receipts, the following three lines are included in the response. Each group
contains name/value pairs with a "|" (pipe) as a delimiter and a ":" (colon) as a separator between the
name and value. Not all pairs will be present at all times. Additional elements may be added in the future.

RECEIPTGROUP1=string
This group contains account and transaction data.

Name Description

TRANSACTIONTYPE Indicates the type of transaction processed.

TRANSACTIONRESULT Indicates whether the transaction was APPROVED or DECLINED.

TIMESTAMP
Timestamp of the transaction in the format MM/DD/YYYY hh:mm:ss
AMPM (e.g., 8/20/2015 4:20:05 PM).

MERCHANTORDERNUMBER Merchant order number (if provided).

MERCHANTID Merchant identifier, masked to the last four digits.

TERMID Terminal identifier.

AMOUNT Amount of the transaction.

ENTRYMETHOD Entry method.

NAME Account holder name.

ACCOUNTTYPE Account type.

ACCOUNT Card number, masked to the last four digits.

ORDERID The Online Merchant Center Order ID for the transaction.

TRANSACTIONID The Online Merchant Center Transaction ID for the transaction.

AUTHCODE
The authorization or approval code provided by the authorizing
network.

DECLINECODE
If the transaction was declined, this value contains the 10-digit
decline code.

DECLINEMESSAGE
For declined transactions, this value may contain a message
indicating the reason for the decline.

RECEIPTGROUP2=string
This group is unused at this time.

RECEIPTGROUP3=string
This group is unused at this time.

Example:

RESULT=SUCCESS
ACCOUNT=9999
AMOUNT=5.00
APPROVALCODE=EXTCK21:001123:::123456789:::
NAME=Default Name
TRANSACTIONID=123456789
ORDERID=123456777
DETAIL=Sale
ACCOUNTTYPE=Check
CHECKNUMBER=1234
ENTRYMETHOD=KEYED
RECEIPTGROUP1=TRANSACTIONTYPE:EXTCK21|TRANSACTIONRESULT:APPROVED|TIMESTAMP:8/20/2015 4:20…
RECEIPTGROUP2=
RECEIPTGROUP3=
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string ShowSignatureCaptureDialog(string, string, short, short)

string ShowSignatureCaptureDialog(string)

This method allows the user to capture a signature image from a supported signature pad. This is a local operation and
does not generate a transaction. The image is returned from the method as an encoded ASCII string.

There are two versions of this method, both named ShowSignatureCaptureDialog. The first version is defined with a
limited set of distinct parameters as described below. The second version accepts a single string as a parameter which
may be composed of multiple named parameters as described for other methods in this guide (see
ShowCreditCardForm); only the /ReturnImage*, /SignaturePrompt, and /CenterScreen parameters apply to
this method.

Parameters:

string ReturnEncoding

Identifies the string representation encoding in which you would like the signature image returned. Valid
values are

Value Description

Base64
Radix-64 encoding; the base 64 digits in ascending order from zero are the uppercase
characters 'A' to 'Z', the lowercase characters 'a' to 'z', the numerals '0' to '9', and the symbols
'+' and '/'. The valueless character, '=', is used for trailing padding.

BinHex
Binary to Hexadecimal encoding; each byte is converted to a hexadecimal string
representation.

string ImageFormat

Identifies the image format in which you would like the signature image returned. Valid values are

Value Description

Bmp Windows bitmap

Emf Enhanced Windows metafile

Gif Graphics Interchange Format

Jpeg Joint Photographic Experts Group image format

Pcl Printer Control Language format

Png Portable Network Graphics image format

Tiff Tag Image File Format

Wmf Windows metafile

short Width

Width, in pixels, for the returned image.

short Height

Height, in pixels, for the returned image.
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Returns:

string Result

String representation of the image based on the specified parameters, or empty if no signature image was
captured.
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string ShowCFNACreditApplication(void)

string ShowCFNACreditApplication(string)

This method allows the user to submit a CFNA credit application. There are two versions of this method, both named
ShowCFNACreditApplication, that may be called with or without a parameter.

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values. This set of values may contain zero or
more parameters, each delimited by a slash (/). For each parameter, the name of the parameter must be
separated from the value by a colon (:).

The following parameters are supported:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant. If omitted and the
ShowConfigDialog method has never been called, then this method will automatically call the
ShowConfigDialog method to collect this required information.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section). If omitted and the ShowConfigDialog method has
never been called, then this method will automatically call the ShowConfigDialog method to
collect this required information.

/FirstName:
Applicant first name.

/MiddleInitial:
Applicant middle initial.

/LastName:
Applicant last name.

/Suffix:
Applicant name suffix.

/DOB:
Applicant date of birth in the format MM-DD-YYYY (e.g., 01-16-1975).

/SSN:
Applicant social security number (e.g., 555-55-5555).

/DLNum:
Applicant driver license number.

/DLState:
Applicant driver license state.

/HomePhone:
Applicant home phone number.

/BusinessPhone:
Applicant business phone number.

/Email:
Applicant email address.

/Income:
Applicant annual income.

/Address1:
Applicant street address.
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/Address2:
Applicant street address second line.

/City:
Applicant city.

/State:
Applicant state.

/Zip:
Applicant zip code.

/YearsAtAddress:
Applicant's number of years at current address.

/PreviousAddress1:
Applicant previous street address.

/PreviousAddress2:
Applicant previous street address second line.

/PreviousCity:
Applicant previous city.

/PreviousState:
Applicant previous state.

/PreviousZip:
Applicant previous zip code.

/RentOrOwn:
Indicates whether applicant rents or owns his/her residence.

Value Description

R Rent

O Own

X Other

/MonthlyHousingCost:
Monthly mortgage or rent payment.

/Tokenize:
Specify 1 to tokenize the credit application. If successful, the response will contain the TOKEN and
LAST4DIGITS instead of the CARDNUMBER.

/PaperAppFormCode:
Paper application form code.

Returns:

string Result

The result of this method call is a multi-line string containing information about the application submission.
Each result element is separated by a CR/LF. Not all elements are present for all transactions. Additional
elements may be added in the future.

RESULT=[NONE|ACCEPTED|DECLINED|ERROR]
Indicates the result of the call:

Value Description

NONE Indicates the application submission was cancelled by the user.

ACCEPTED Indicates the application was successfully submitted.

DECLINED Indicates the application submission was declined.

ERROR Indicates there was an error with the application submission.
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DETAIL=string
Provides additional detail about the RESULT.

TRANSACTIONID=numeric
The Online Merchant Center Transaction ID for the application submission.

ORDERID=numeric
The Online Merchant Center Order ID for the transaction.

CONFIRMATIONNUMBER=string
The confirmation number provided by CFNA to reference the application.

CARDNUMBER=numeric
If the application is approved, the 9-digit CFNA card number for the application.

CREDITLIMIT=numeric
If the application is approved, the credit limit for the CFNA card.
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string ShowCreditApplication(string)

This method allows the user to submit a credit application for CarCareONE, Goodyear, Service Central, or Drive Card.

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values. This set of values may contain zero or
more parameters, each delimited by a slash (/). For each parameter, the name of the parameter must be
separated from the value by a colon (:).

The following parameters are supported:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant. If omitted and the
ShowConfigDialog method has never been called, then this method will automatically call the
ShowConfigDialog method to collect this required information.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section). If omitted and the ShowConfigDialog method has
never been called, then this method will automatically call the ShowConfigDialog method to
collect this required information.

/CreditApp:
Indicates the type of credit application.

Value Description

GEMY CarCareONE

DRVE Drive Card

GDYR Goodyear

SERV Service Central

/FirstName:
Applicant first name.

/MiddleName:
Applicant middle name.

/LastName:
Applicant last name.

/DOB:
Applicant date of birth in the format MM-DD-YYYY (e.g., 01-16-1975).

/SSN:
Applicant social security number (e.g., 555-55-5555).

/DLNum:
Applicant driver license number.

/DLState:
Applicant driver license state.

/DLExp:
Applicant driver license expiration in the format MM-YYYY (e.g., 12-2015)

/PhotoID:
Applicant photo ID number.

/PhotoIDState:
Applicant photo ID state of issuance.
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/PhotoIDExp:
Applicant photo ID expiration in the format MM-YYYY (e.g., 12-2015)

/HomePhone:
Applicant home/primary phone number.

/BusinessPhone:
Applicant business phone number.

/MobilePhone:
Applicant mobile phone number.

/Email:
Applicant email address.

/Income:
Applicant annual salary and wages.

/OtherIncomeAmount:
Applicant other annual income.

/Address1:
Applicant street address.

/Address2:
Applicant street address second line.

/City:
Applicant city.

/State:
Applicant state.

/Zip:
Applicant zip code.

/RentOrOwn:
Indicates whether applicant rents or owns his/her residence.

Value Description

R Rent

O Own

X Other

/YearsAtAddress:
Applicant's number of years at current address.

/TimeAtJob:
Applicant's time at current job in YYMM format (e.g., 0006 - six months, 0100 - one year).

/MonthlyHousingCost:
Monthly mortgage or rent payment.

/Tokenize:
Specify 1 to tokenize the credit application. If successful, the response will contain the TOKEN and
LAST4DIGITS instead of the CARDNUMBER.

The following parameters only apply to CarCareONE.

/JointAccount:
Specify 1 to indicate an application for a joint account.

/CoApp*:
The following fields mirror those listed above but apply to the co-applicant:
CoAppFirstName, CoAppMiddleName, CoAppLastName, CoAppDOB, CoAppSSN,
CoAppDLNum, CoAppDLState, CoAppDLExp, CoAppPhotoID, CoAppPhotoIDState,
CoAppPhotoIDExp, CoAppHomePhone, CoAppBusinessPhone, CoAppMobilePhone,
CoAppEmail, CoAppIncome, CoAppAddress1, CoAppAddress2, CoAppCity, CoAppState,
CoAppZip, CoAppRentOrOwn, CoAppYearsAtAddress, CoAppTimeAtJob.
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Additionally, if /CreditApp:GEMY is specified, the following parameters are also available:

/Action:
Specifies the action to perform.

Value Description

QuickScreen Check if a customer is pre-approved for a CarCareONE card.

CreditDecision Check the status of a pending credit application.

AcceptQuickScreen Accept a QuickScreen offer.

DeclineQuickScreen Decline a QuickScreen offer.

For CreditDecision, AcceptQuickScreen, and DeclineQuickScreen an OrderID and
TransactionID are required. The user is prompted for this information if not provided in the
method call.

Returns:

string Result

The result of this method call is a multi-line string containing information about the application submission.
Each result element is separated by a CR/LF. Not all elements are present for all transactions. Additional
elements may be added in the future.

RESULT=[NONE|ACCEPTED|DECLINED|PENDING|ERROR]
Indicates the result of the call:

Value Description

NONE Indicates the application submission was cancelled by the user.

ACCEPTED Indicates the application was successfully submitted.

DECLINED Indicates the application submission was declined.

PENDING Indicates the application submission is pending (CarCareONE only).

ERROR Indicates there was an error with the application submission.

DETAIL=string
Provides additional detail about the RESULT.

TRANSACTIONID=numeric
The Online Merchant Center Transaction ID for the application submission.

ORDERID=numeric
The Online Merchant Center Order ID for the transaction.

CONFIRMATIONNUMBER=string
The confirmation number provided by the credit application provider to reference the application.

TOKEN=numeric
If the application is approved and the /Token:1 parameter was provided, the account is
tokenized and may be referenced with this value in addition to LAST4DIGITS.

LAST4DIGITS=numeric
If the application is approved and tokenized, the account may be referenced with this value in
addition to TOKEN.
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CARDNUMBER=numeric
If the application is approved and the account is not tokenized, the card number for the
application.

CREDITLIMIT=numeric
If the application is approved, the credit limit for the card.

FIRSTNAME=string
First name of the applicant.

LASTNAME=string
Last name of the applicant.

ADDRESS1=string
Street address of the applicant.

ADDRESS2=string
Second line of the street address of the applicant.

CITY=string
City of the applicant's address.

STATE=string
State of the applicant's address.

ZIPCODE=string
Zip code of the applicant's address.

PHONE=string
Applicant's phone number.

EMAIL=string
Applicant's email address.

PREAPPROVALEXPDATE=YYYYMMDD
An approved CarCareONE QuickScreen can be accepted until the expiration given expiration
date.

Online Commerce Suite™ First Mile™ MiddleWare Guide

Page 37



string ShowAccountLookupDialog(string)

This method shows the account lookup/balance inquiry dialog.

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values and control its behavior. This set of
values may contain zero or more parameters, each delimited by a slash (/). For each parameter, the
name of the parameter must be separated from the value by a colon (:).

The following parameters are supported:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant. If omitted and the
ShowConfigDialog method has never been called, then this method will automatically call the
ShowConfigDialog method to collect this required information.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section). If omitted and the ShowConfigDialog method has
never been called, then this method will automatically call the ShowConfigDialog method to
collect this required information.

/SSN:
Social Security number. Required for account lookup.

/Zip:
Cardholder zip code (e.g., 98052). Required for account lookup.

/CCNumber:
Card number. Required for balance inquiry.

/PhotoIDType:
Specifies the Photo ID type. Photo ID is only required if performing an account lookup and the
user chooses to perform a sale on the account. Valid values are

Value Description

D Driver License (default)

G Green Card

M Military ID

P Passport

S State ID Card

/PhotoIDNumber:
Specifies the identification number (which may contain characters) on the Photo ID.

/PhotoIDExpDate:
Specifies the Photo ID expiration date in format MM-DD-YYYY or MM-YYYY.

/CenterScreen:
If this parameter is present with the value 1, the dialog is shown centered on the screen rather
than the default position of centering the dialog on the calling window.

/CheckForUpdateInterval:
The number of days between checks for updates.

/CheckForUpdates:
Specify 0 to disable checking for updates, or 1 to enable update checking for updates.
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/SuppressAcceptedDialog:
Specify 1 to suppress the Accepted dialog which is normally shown for accepted transactions.
Declined and Error dialogs will still be shown.

All parameters are optional and may be omitted.

Returns:

string Result

The result of this method call is a multi-line string containing information about the action that was
performed. For a balance inquiry the following fields are not returned: FIRSTNAME, LASTNAME,
ADDRESS1, ADDRESS2, CITY, STATE, ZIPCODE, PHONE. Each result element is separated by a
CR/LF. Not all elements are present for all transactions. Additional elements may be added in the future.

RESULT=[NONE|SUCCESS|DECLINED|ERROR]
Indicates the status of the call:

Value Description

NONE Indicates no transaction was performed.

SUCCESS Indicates the transaction was successful.

DECLINED Indicates the transaction was declined.

ERROR Indicates an error occurred.

Note: if Auto Updates are enabled and the user assents to the Auto Update process, the value of
this tag will be NONE and the DETAIL tag will contain the value Update in progress.

ACCOUNT=numeric
The last four digits of the account number (if available).

APPROVALCODE=string
The Authorization Code of the transaction.

TRANSACTIONID=numeric
The Online Merchant Center Transaction ID for the transaction.

ORDERID=numeric
The Online Merchant Center Order ID for the transaction.

DETAIL=string
For DECLINED and ERROR results, this field provides details about the failure.

ACCOUNTTYPE=string
Identifies the credit card type that was processed:

 AMEX  CarCareONE  CFNA  Check

 Debit  Diners Club  Discover Network  Drive Card

 Fleet One  Flying J  FuelLynk  FuelMan

 GE Money  Goodyear  JCB  MasterCard

 MasterCard Fleet  Service Central  Visa  Visa Fleet

 Voyager  WP Gift Card  Wright Express

FIRSTNAME=string
The first name of the account holder.

LASTNAME=string
The last name of the account holder.

Online Commerce Suite™ First Mile™ MiddleWare Guide

Page 39



ADDRESS1=string
The mailing address of the account holder.

ADDRESS2=string
The second line of the mailing address of the account holder.

CITY=string
The account holder's mailing address city.

STATE=string
The account holder's mailing address state.

ZIPCODE=string
The account holder's mailing address zip code.

PHONE=string
The account holder's phone number.

BALANCE=numeric
Balance of the card.

Example:

RESULT=SUCCESS
ACCOUNT=5454
APPROVALCODE=ACCOUNTLOOKUP:TEST:::111111111:N::U
TRANSACTIONID=111111111
ORDERID=111111112
ACCOUNTTYPE=Goodyear
FIRSTNAME=John
LASTNAME=Rook
ADDRESS1=11121 Willows Rd NE
ADDRESS2=
CITY=Redmond
STATE=WA
ZIPCODE=98052
PHONE=(866) 242-9933
BALANCE=2200
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string ShowTokenLookupDialog(string)

This method shows the tokenized account lookup dialog. A tokenized account allows a merchant to process returning
customers without the need to store sensitive and confidential customer information on the merchant's system. Storing
sensitive information requires secure servers in addition to various certifications. Merchant Partners is CISP (Visa's
Cardholder Information Security Program) certified. Therefore, we take all precautions to ensure the customer's data is
safe and eliminating the need for the merchant to run the risk of exposing their customers' sensitive data. Tokenization
makes the transaction experience safer for the merchant and easier for the customer. A tokenized account is referred to
as "Account on File" in the user interface.

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values and control its behavior. This set of
values may contain zero or more parameters, each delimited by a slash (/). For each parameter, the
name of the parameter must be separated from the value by a colon (:).

The following parameters are supported:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant. If omitted and the
ShowConfigDialog method has never been called, then this method will automatically call the
ShowConfigDialog method to collect this required information.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section). If omitted and the ShowConfigDialog method has
never been called, then this method will automatically call the ShowConfigDialog method to
collect this required information.

/Token:
Numeric token supplied by Merchant Partners.

/Last4Digits:
The last four digits of the credit card or bank account number.

Returns:

string Result

The result of this method call is a multi-line string containing information about the transaction that was
processed. Each result element is separated by a CR/LF. Not all elements are present for all transactions.
Additional elements may be added in the future.

RESULT=[NONE|SUCCESS|DECLINED|ERROR]
Indicates the status of the call:

Value Description

NONE Indicates no transaction was performed.

SUCCESS Indicates the transaction was successful.

DECLINED Indicates the transaction was declined.

ERROR Indicates an error occurred.
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Note: if Auto Updates are enabled and the user assents to the Auto Update process, the value of
this tag will be NONE and the DETAIL tag will contain the value Update in progress.

ACCOUNT=numeric
The last 4 digits of the account that was retrieved.

APPROVALCODE=string
The Authorization Code of the transaction.

TOKEN=numeric
The Token used for account retrieval.

LAST4DIGITS=numeric
The last 4 digits of the account that was retrieved.

ACCOUNTTYPE=string
Identifies the credit card type that was processed:

 AMEX  CarCareONE  CFNA  Check

 Debit  Diners Club  Discover Network  Drive Card

 Fleet One  Flying J  FuelLynk  FuelMan

 GE Money  Goodyear  JCB  MasterCard

 MasterCard Fleet  Service Central  Visa  Visa Fleet

 Voyager  WP Gift Card  Wright Express

NAME=string
The Account Holder name, if available.

ADDRESS1=string
The mailing address of the account holder.

ADDRESS2=string
The second line of the mailing address of the account holder.

CITY=string
The account holder's mailing address city.

STATE=string
The account holder's mailing address state.

ZIPCODE=string
The account holder's mailing address zip code.

PHONE=string
The account holder's phone number.

EMAIL=numeric
The account holder's email address.

Example:

RESULT=SUCCESS
ACCOUNT=5454
APPROVALCODE=PROFILERETRIEVE:Success:::0:::
TOKEN=1111111
LAST4DIGITS=5454
ACCOUNTTYPE=MasterCard
NAME=James Test
ADDRESS1=11121 Willows Rd NE
ADDRESS2=
CITY=Redmond
STATE=WA
ZIPCODE=98052
PHONE=(866) 242-9933
EMAIL=support@merchantpartners.com
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string ShowGiftCardDialog(string)

This method shows the gift card dialog for a given action.

Parameters:

string InitializationParameters

This parameter allows you to initialize the form with a set of values and control its behavior. This set of
values may contain zero or more parameters, each delimited by a slash (/). For each parameter, the
name of the parameter must be separated from the value by a colon (:).

The following parameters are supported:

/ATSID:
5-character alphanumeric value (Acct ID) that identifies the merchant. If omitted and the
ShowConfigDialog method has never been called, then this method will automatically call the
ShowConfigDialog method to collect this required information.

/ATSSubID:
5-character alphanumeric value that identifies the SubID for the merchant.

/MerchantPIN:
The Merchant PIN value from the Online Merchant Center (under the FRISK™ Management >
Configure Options > API Controls section). If omitted and the ShowConfigDialog method has
never been called, then this method will automatically call the ShowConfigDialog method to
collect this required information.

/GiftCardAction:
Identifies the gift card action to perform:

Value Description

Issue Issue a new gift card.

AddValue Add value to a gift card.

BalanceInquiry Perform a balance inquiry on a gift card.

Deactivate Deactivate an existing gift card.

/Amount:
Dollar amount of the transaction (e.g., 1.23)

/RequireGiftCardActivationSwipe:
Specify 1 to require a swipe for Gift Card Activation/Add Value.

/CenterScreen:
If this parameter is present with the value 1, the dialog is shown centered on the screen rather
than the default position of centering the dialog on the calling window.

/LockParameters:
If this parameter is present with the value 1, the Amount field, if provided in the parameter set, will
be locked as read-only for AddValue and Issue actions.

/SwipeImmediate:
If this parameter is present with the value 1, then the Swipe dialog is shown immediately upon
launch of the dialog.

/ProcessOnSwipe:
If this parameter is present with the value 1, then the transaction is processed immediately after a
successful card swipe.

/SuppressAcceptedDialog:
Specify 1 to suppress the Accepted dialog which is normally shown for accepted transactions.
Declined and Duplicate Transaction dialogs will still be shown.

/AcceptedDialogTimeout:
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This parameter causes the Accepted dialog which is normally shown for accepted transactions to
be automatically dismissed after the given number of seconds (a positive integer).

Returns:

string Result

The result of this method call is a multi-line string containing information about the transaction that was
processed. Each result element is separated by a CR/LF. Not all elements are present for all transactions.
Additional elements may be added in the future.

RESULT=[NONE|SUCCESS|DECLINED|ERROR]
Indicates the status of the call:

Value Description

NONE Indicates no transaction was performed.

SUCCESS Indicates the transaction was successful.

DECLINED Indicates the transaction was declined.

ERROR Indicates an error occurred.

Note: if Auto Updates are enabled and the user assents to the Auto Update process, the value of
this tag will be NONE and the DETAIL tag will contain the value Update in progress.

ACCOUNT=numeric
The last 4 digits of the account that was retrieved.

AMOUNT=decimal
The amount of the transaction.

APPROVALCODE=string
The Authorization Code of the transaction.

TRANSACTIONID=numeric
The Online Merchant Center Transaction ID for the transaction.

ORDERID=numeric
The Online Merchant Center Order ID for the transaction.

DETAIL=string
This value identifies the transaction type and any additional information about the transaction.
For declined transactions, this value contains the processing gateway's decline reason.
If the user assents to the Auto Update process, this tag will contain the value Update in progress.

ACCOUNTTYPE=string
Identifies the card type that was processed:

 WP Gift Card

TERMID=string
This optional tag may be included to identify the Terminal on which the transaction originated.

BALANCE=numeric
Balance remaining on card.

Example:

RESULT=SUCCESS
ACCOUNT=3048
AMOUNT=
APPROVALCODE=SVBALINQRY:G20721:52::111111111:::
TRANSACTIONID=111111111
ORDERID=211111111
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DETAIL=GiftCard
ACCOUNTTYPE=WP Gift Card
TERMID=111111
BALANCE=55.50
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Sample Code

Visual Basic 6

The following example shows how to use First Mile MiddleWare in a Visual Basic 6 project.

Note: It may be necessary to register First Mile MiddleWare as follows to operate with VB6:

RegAsm /codebase ATSSecurePostUILib.dll

From the Project menu, choose References...1. 
Place a check mark in the ATSSecurePostUILib entry and click OK2. 
In your code:

Sub ShowCCForm()
    Dim sInitParams As String
    Dim sResult As String
    Dim oSecurePostUI As ATSSecurePostUILib.ATSSecurePostUI
    Set oSecurePostUI = New ATSSecurePostUILib.ATSSecurePostUI

    ' Create your initialization parameters
    sInitParams = ""

    ' Show the form
    sResult = oSecurePostUI.ShowCreditCardForm(sInitParams)

    ' Perform actions based on result
    Debug.Print (sResult)
End Sub

3. 

Converting Encoded Images

The following example shows how to decode a Base64 encoded image from the IMAGE parameter of the
ShowCreditCardForm method.

In your VB6 project, add a reference to Microsoft XML, v2.6 (or later)

Private Function DecodeBase64(ByVal strBase64Encoded As String) As Byte()
    Dim objXML As MSXML2.DOMDocument
    Dim objNode As MSXML2.IXMLDOMElement

    ' help from MSXML
    Set objXML = New MSXML2.DOMDocument
    Set objNode = objXML.createElement("b64")
    objNode.dataType = "bin.base64"
    objNode.Text = strBase64Encoded
    DecodeBase64 = objNode.nodeTypedValue

    Set objNode = Nothing
    Set objXML = Nothing
End Function

Dim byteData() As Byte
byteData = DecodeBase64(strHexEncoded)
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The following example shows how to decode a BinHex encoded image from the IMAGE parameter of the
ShowCreditCardForm method.

Private Function HexStringToBytes(strHexEncoded As String) As Byte()
    If strHexEncoded  vbNullString Then
        Dim i As Integer, j As Integer, byteArr() As Byte
        ReDim byteArr(0 To (Len(strHexEncoded) / 2) - 1) As Byte
        For i = 1 To Len(strHexEncoded) Step 2
            byteArr(j) = CByte(Val("&H" & Mid(strHexEncoded, i, 2)))
            j = j + 1
        Next i
        HexStringToBytes = byteArr
    End If
End Function

Dim byteData() As Byte
byteData = HexStringToBytes(strHexEncoded)

C#

The following example shows how to use First Mile MiddleWare in a C# .NET project.

Note: It may be necessary to target .NET Framework 2.0 in your project if you plan to use add-on hardware modules.

From the Project menu, choose Add Reference...1. 
Click the Browse tab and browse to the location where you saved ATSSecurePostUILib.dll.2. 
Click ATSSecurePostUILib.dll and then click the OK button.3. 
In your code:

// create an ATSSecurePostUI object
ATSSecurePostUILib.ATSSecurePostUI o = new ATSSecurePostUILib.ATSSecurePostUI();

// set your initialization parameters
string sInitParams = "";

// show the form
string sResult = o.ShowCreditCardForm(sInitParams);

// perform actions based on the result
System.Diagnostics.Debug.WriteLine(sResult);

4. 

Converting Encoded Images

The following example shows how to decode a Base64 encoded image from the IMAGE parameter of the
ShowCreditCardForm method.

// sBase64EncodedImage is the string pulled from the IMAGE parameter of a ShowCreditCardForm result
Bitmap bmp = new Bitmap(new MemoryStream(System.Convert.FromBase64String(sBase64EncodedImage)));
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The following example shows how to decode a BinHex encoded image from the IMAGE parameter of the
ShowCreditCardForm method.

byte[] HexStringToBytes(string sHexString)
{
    byte[] data = new byte[sHexString.Length / 2];
    for (int i = 0, j = 0; i < sHexString.Length; i += 2)
    {
        string sByte = sHexString.Substring(i, 2);
        data[j++] = Convert.ToByte(sByte, 16);
    }
    return data;
}

// sBinHexEncodedImage is the string pulled from the IMAGE parameter of a ShowCreditCardForm result
Bitmap bmp = new Bitmap(new MemoryStream(HexStringToBytes(sBinHexEncodedImage)));
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Appendix A: Fleet Card Line Item Details
Line item details are required for fleet card transactions.

Line item details are delimited by a | (pipe). Example:

LineItem|LineItem|LineItem

Each Line item can contain multiple Item Product Codes. Item Product Codes (IPC) are delimited by ; (semi-colon).
Example:

IPC;IPC;IPC

Each IPC has a value that is delimited by : (colon).

A full example of two line items with multiple item product codes per line item:

512:133;513:1.0000;518:99.0000;510:99.00|512:950;513:1.0000;518:9.4000;510:9.40

This example describes two line items, Repairs for $99 and Tax for $9.40 and can be broken down by IPC as follows:

Line Item #1
512:133 Product Code: 133 - Repairs
513:1.0000 Quantity: 1.0000
518:99.0000 Unit Price: 99.0000
510:99.00 Line Item Total Cost: 99.00
Line Item #2
512:950 Product Code: 950 - Tax 1
513:1.0000 Quantity: 1.0000
518:9.4000 Unit Price: 9.4000
510:9.40 Line Item Total Cost: 9.40

Item Product Code Description Data Type Length

508 Item Description AN Variable

510 Line Item Total Cost; 9(6)v99 N 8

512 Product Code (See Appendix B) N 3

513 Quantity/Num Units; 9(3)v9999 N 7

514 Service Code/Level (See Appendix C) AN 1

513 Quantity/Num Units; 9(3)v9999 N 7

518 Unit Cost/Price; 9(6)v9999 N 10

519 Unit of Measure (See Appendix D) AN 1

522 Discount Rate; 9(6)v99 N 8
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Appendix B: Product Codes

Product Code Description

Fuels

001 Unleaded Regular

002 Unleaded Plus

003 Unleaded Super

004 Unleaded 4

005 Unleaded 5

006 Unleaded Methanol (5.7%)

007 Unleaded Plus Methanol (5.7%)

008 Super Unleaded Methanol (5.7% blend)

009 Unleaded Methanol (7.7%)

010 Unleaded Plus Methanol (7.7% blend)

011 Unleaded Ethanol (5.7%)

012 Unleaded Plus Ethanol (5.7%)

013 Super Unleaded Ethanol (5.7%)

014 Unleaded Ethanol (7.7%)

015 Unleaded Plus Ethanol (7.7%)

016 Methanol / Leaded

017 Ethanol / Leaded

018 Leaded

019 Regular Diesel #2

020 Premium Diesel #2

021 Diesel #1

022 Compressed Natural Gas

023 Liquid Propane Gas

024 Liquid Natural Gas

025 M-85

026 E-85

027 Unleaded / Reformulated 1

028 Unleaded / Reformulated 2

029 Unleaded / Reformulated 3

030 Unleaded / Reformulated 4

031 Unleaded / Reformulated 5

032 Diesel Off-Road (# 1 and #2 Non-Taxable)

033 Ultra Low Sulfur Diesel Off-Road (Non-Taxable)

034 Biodiesel Blend Off-Road (Non-Taxable)

035 Ultra Low Sulfur Biodiesel Off-Road (Non-Taxable)

036 Racing Fuel
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037 Super Unleaded Methanol (7.7%)

038 Unleaded Methanol (10%)

039 Unleaded Plus Methanol (10%)

040 Dyed Diesel

Product Code Description

041 Super Unleaded Methanol (10%)

045 B2 Diesel Blend 2% Biodiesel

046 B5 Diesel Blend 5% Biodiesel

047 B10 Diesel Blend 10% Biodiesel

048 B11 Diesel Blend 11% Biodiesel

049 B15 Diesel Blend 15% Biodiesel

050 B20 Diesel Blend 20% Biodiesel

051 B100 Diesel Blend 100% Biodiesel

052 Ultra Low Sulfur #1

053 Ultra Low Sulfur #2

054 Ultra Low Sulfur Premium Diesel #2

055 Ultra Low Sulfur Biodiesel Blend 2%

056 Ultra Low Sulfur Biodiesel Blend 5%

057 Ultra Low Sulfur Biodiesel Blend 10%

058 Ultra Low Sulfur Biodiesel Blend 11%

059 Ultra Low Sulfur Biodiesel Blend 15%

060 Ultra Low Sulfur Biodiesel Blend 20%

061 Ultra Low Sulfur Biodiesel Blend 100%

099 Miscellaneous Fuel

Auto Products / Services

100 General Merchandise

101 Motor Oil

102 Car Wash

103 Oil Change

104 Oil Filter

105 Work Order

106 Anti-Freeze

107 Washer Fluid

108 Brake Fluid

109 Tires

110 Federal Excise Tax / Tires

111 Tire Rotation

112 Batteries

113 Lube

114 Inspection
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115 Labor

116 Towing

117 Road Service

118 Auto Accessories

119 Auto Parts

120 Preventive Maintenance

121 Air Conditioning Service

122 Engine Service

Product Code Description

123 Transmission Service

124 Brake Service

125 Exhaust Service

126 Body Work

127 Automotive Glass

128 Synthetic Oil

129 Lamps

130 Wipers

131 Hoses

132 Tire-related (Wheel Balance, Valve Stem)

133 Repairs

134 Service Package

135 Automotive Parking

136 Truck Tank Cleaning

137 Other Lubricants

138 Automotive Fuel Additives/Treatment (injected)

149 Miscellaneous Part/Services

Aviation Fuels

150 Jet Fuel

151 Aviation Fuel Regular

152 Aviation Fuel Premium

153 Aviation Fuel JP8

154 Aviation Fuel 4

155 Aviation Fuel 5

199 Miscellaneous

Aviation Products / Services

200 Storage

201 Aircraft Ground Handling

202 Aircraft Ground Power Unit

203 Aircraft Labor

204 Aircraft Work Order
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205 Aircraft Maintenance

206 Aircraft Service

207 Transportation

208 De-icing

209 Ramp Fees

210 Catering

211 Hangar Fee

212 Landing Fee

213 Call Out Fee

214 Aircraft Rental

215 Instruction Fee

216 Flight Plans/ Weather Brief

Product Code Description

217 Charter Fee

218 Communication Fee

219 Aircraft Cleaning

220 Cargo Handling

221 Aircraft Accessories

222 Pilot Supplies

223 Aircraft Parking Fee

224 Aircraft Tiedown Fees

225 Aircraft Sanitation Fees

226 Aircraft Fuel Additive

249 Miscellaneous Aviation

Marine Products / Services

300 Marine Services

301 Marine Labor

302 Marine Work Order

303 Launch Fee

304 Slip Rental

349 Miscellaneous Marine Service

Other Fuels

350 Kerosene - Low Sulfur

351 White Gas

352 Heating Oil

353 Bottled Propane

354 Other Fuel / Non-taxable

355 Kerosene - Ultra Low Sulfur

356 Kerosene -Low Sulfur (Non-Taxable)

357 Kerosene -Ultra Low Sulfur (Non-Taxable)
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449 Miscellaneous / Other Fuel

Merchandise

450 General Merchandise

451 Cigarettes

452 Tobacco - Other

453 Pkg Bvgs / Non-alcoholic

454 Hot Dispensed Bvgs

455 Cold Dispensed Bvgs

456 Frozen dispensed Bvgs

457 Other Beverages

458 Ice

459 Packaged Ice Cream

460 Salty Snacks

461 Alternative Snacks

462 Sweet Snacks

463 Candy

Product Code Description

464 Fluid Milk Product

465 Other Dairy

466 Juice

467 Edible Groceries

468 Non-edible Groceries

469 Perishable Groceries

470 Publications

473 Healthy/Beauty Care

474 Beer (Alcoholic)

475 Beer (Non-alcoholic)

476 Wine

477 Liquor

478 Deli Sandwiches

479 Prepared Food

480 Deli Items

481 Food Service

482 Lottery (Instant)

483 Lottery (Online)

484 Lottery (Other)

485 General

486 Vendor Payment

487 Payroll Check

488 Gift Certificate
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489 Refund Check

490 Official Check

491 Rebate Check

492 Dividend Check

493 Utility Check

503 Store Services

504 Home Delivery

505 Prepaid Cards- Purchase

506 Prepaid Cards-Activation

507 Membership/Loyalty

Negative Transactions

900 Discount 1

901 Discount 2

902 Discount 3

903 Discount 4

904 Discount 5

905 Coupon 1

906 Coupon 2

907 Coupon 3

908 Coupon 4

Product Code Description

909 Coupon 5

910 Lotto Payout (Instant)

911 Lotto Payout (Online)

912 Lotto Payout (Other)

913 Split Tender

914 Tax Discount/Forgiven

949 Miscellaneous Negative

Administrative

950 Tax 1

951 Tax 2

952 Tax 3

953 Tax 4

954 Tax 5

955 Cash back

956 Cash back Fee

957 Fee 1

958 Fee 2

959 Fee 3

960 Fee 4
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961 Fee 5

962 Miscellaneous Aviation Tax
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Appendix C: Fleet Card Service Codes

Value Description

F Full Service

S Self Service

N Mini Serve

X Maxi Serve

O Other or Non-Fuel
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Appendix D: Measurement Codes

Value Description

C Case/Carton

G Gallons

K Kilograms

L Liters

P Pounds

Q Quarts

U Units

Z Ounces

X Undefined
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